In these lessons, a focus is placed on using keyboard shortcuts. These lessons are meant to review or enhance your current curriculum. An answer key is provided for the teacher. These lessons are best used with a PC running Windows 7 and JAWS. Use the training materials provided by Freedom Scientific to learn JAWS to a greater extent.
Contents:

Lesson A: JAWS Laptop Layout
Lesson B: Starting JAWS
Lesson C: JAWS Start-Up Wizard
Lesson D: The JAWS Options Menu
Lesson 1: The PC Desktop
Lesson 2: Computer or My Computer
Lesson 3: Microsoft Word
Lesson 4: Insert Clipart
Lesson 5: Maximize or Minimize
Lesson 6: Reading in a Word Document
Lesson 7: Cut, Copy, and Paste
Lesson 8: Dialog Boxes
Lesson 9: Format Text
Lesson 10: Change the Background
Lesson 11: Folders and Files
Lesson 12: Internet
Lesson 13: Create a Shortcut Command
Lesson 14: JAWS and Reading a Web Page
Lesson 15: Forms on the Internet
Lesson A

JAWS Laptop Layout

Introduction

When using JAWS, you can choose between using a laptop keyboard layout or a desktop keyboard layout. The keyboard layouts are not quite the same. A laptop keyboard does not usually have a NUMPAD (number pad). So different keystrokes are used.

If you have a laptop, you will be changing the keyboard layout to "laptop". The CAPSLOCK key will become a modifier for the INSERT key. This means that when INSERT is used in a keystroke, the CAPSLOCK can be used to replace the INSERT key. CAPSLOCK is often easier to reach compared with insert. You won't have to move your hands off of homerow to reach CAPSLOCK.

To use the CAPSLOCK key to capitalize all letters, press the key twice quickly. Pressing the CAPSLOCK twice quickly when JAWS is running in laptop keyboard layout will allow you to use CAPSLOCK for its original purpose.
Lesson A

JAWS Laptop Layout

Show What You Know:

1. What is the difference between many laptop and standard PC keyboards?

2. What key will become a modifier key for the INSERT key?

3. What is a modifier key?

4. If you want to put a word in all caps, what will you do when using the JAWS laptop keyboard layout?
Lesson A

Jaws Laptop Layout

Try It Out:

Follow the steps below to practice important JAWS commands.

First, set your keyboard layout to "laptop".

1. Alt + tab to open the JAWS window.
2. Alt to jump to the menu bar.
3. Down arrow to open the "options" menu.
4. Down arrow to "basics".
5. Press enter.
6. Tab to "use keyboard layout".
7. Left arrow or right arrow to "laptop".
8. Press enter. Pressing enter activates the OK button and saves the changes.

You can use keyboard help to get to know the laptop keyboard layout.

1. Press CAPSLOCK + 1. This will toggle keyboard help on or off. Try this now.
2. Practice the JAWS keystrokes listed here while "keyboard help" is on to learn what the keystrokes do.

   a. insert + m (remember to use CAPSLOCK as the modifier key
   b. insert + ,
   c. insert + .
   d. insert + j
   e. insert + k
   f. insert + l
   g. insert + u
   h. insert + i
   i. insert + o
3. What did these keystrokes do? The keystrokes will work any time JAWS is running.
4. Use keyboard help now to get to know the laptop layout.
5. Press the key or keystroke twice quickly to get a more detailed description of what the key or keystroke will do.
When you install JAWS on your computer, a JAWS icon will be placed on the desktop. This is a shortcut to turn JAWS on. There is more than one method you can use to turn JAWS on. Setting up a JAWS hotkey is another method that can be used to start JAWS.

When JAWS is running, you can shut it off as needed. The keyboard command used to turn JAWS off is INSERT + F4. After you press the command, a shut-down dialog box will appear. Press enter to shut JAWS off.
Lesson B
Starting JAWS

Show What You Know:

1. When installing JAWS, where is a shortcut to run the program placed?

2. What is a second method that can be used to run JAWS?

3. What is the keyboard command to shut JAWS off?

4. How can you turn keyboard help on or off?
Lesson B
Starting JAWS

Try It Out:

One method to start JAWS is to start it from the icon on the desktop. Follow the below steps to practice.

1. Press windows key + d to bring focus to the desktop.
2. Press j for JAWS. This will bring focus to the JAWS icon. If you have more than one icon starting with letter j, you may have to press j more than once.
3. Check to see where you are. Use the say line command. Press insert + up arrow.
4. Press enter to start JAWS.
5. The JAWS window will open. JAWS will start running.

Now learn to set up a hotkey that will start JAWS.

1. Press windows key + d to focus on the desktop.
2. Press letter j until the JAWS shortcut icon is selected. If JAWS does not say "selected", then press spacebar to select the icon. Pressing enter would open the window. We don't want to open the JAWS window at this time, just to select it.
3. Press alt + enter to open the properties dialog box.
4. When "properties" is opened, you will be on a multi-page dialog box. Focus will probably be on the "shortcut" page.
5. If you are not on the "shortcut" page, press control + tab until focus is on the correct page.
6. Press tab until you get to the "shortcut" or "hotkey".
7. Press the letter j. The computer will assume you want control + alt + j as the shortcut. When you press the letter j, control + alt + j now becomes the hotkey to turn JAWS on.
8. Confirm that you set the hotkey correctly. Use the hotkey to read the current control. Insert + tab will read the current control and a message.
9. Tab once. Though you don't need to change this for JAWS, the "run" option tells how the program should be run. For JAWS, keeping the choice at "normal window" is fine.
10. If you are setting up a hotkey for a program such as Microsoft Word, you would want to ensure the program runs "maximized" in the largest window possible. You can arrow down and up to explore the choices.
11. For JAWS, run in the normal window.
12. Tab to the OK button. Press space to confirm the changes. You may need to take other actions depending on how your administrative settings for your PC are set up.
13. Press enter on the continue button to confirm the change.
14. Test to see if the hotkey worked. First close JAWS. Turn the screen reader off by pressing the hotkey insert + F4.

15. Press Space to turn JAWS off.
16. Now turn JAWS on. Try the hotkey you set. Press control + alt + j. Hopefully it worked and JAWS will start running again.
Lesson C

JAWS Start-Up Wizard

Introduction

When JAWS is installed, a start-up wizard will run. You can access this wizard at any time to manipulate JAWS settings. The speech rate, punctuation level, and typing echo can be changed to meet your preferences. The typing echo is what you hear when you keyboard.

There are other settings in the JAWS start-up wizard that can be altered. You can control how JAWS is started. If you do not always use JAWS, you can set the option to have JAWS never run automatically. In this case, JAWS would need to be turned on by using a hotkey, desktop icon, or by going through the start menu. In the wizard, you can set JAWS to run at the log in screen or after the log in screen.

Other options can be changed by using the JAWS start-up wizard. Keyboard, braille, and verbosity options can be modified. At any time when using JAWS, you can get help. Insert + F1 will give help. After listening to information gained from insert + F1 help, use escape to close help.
Lesson C
JAW Start-Up Wizard

Show What You Know:

1. Give 3 options that the JAWS start-up wizard can help you change?

2. To get JAWS help from anywhere, what command can be used?

3. How can "JAWS help" be closed?

4. What is the command to bring focus to the desktop?
Lesson C

JAWS Start-Up Wizard

Try It Out:

Learn to use the JAWS start-up wizard to quickly change options to meet your preferences. Follow the steps below to start the wizard:

1. Press `alt + tab` to switch to the JAWS window. If you have JAWS running, this JAWS window will also be running.
2. Press `alt + h` to open the help menu.
3. Press letter `z` to open the startup wizard.

Complete these steps with your student. Use the start-up wizard to make changes and start learning what your preferences are.

1. The first option allows you to install the tutorial from the JAWS CD. Follow the instructions given to do this. Older students would greatly benefit from listening to training materials from Freedom Scientific. It is also suggested that instructors listen to the tutorials provided in the Training section of the JAWS "help" menu.
2. If you have already installed the tutorial, press `enter` to go to the next screen.
3. In the dialog box that appears, you can control the JAWS speech settings. You can adjust the voice rate, the punctuation, and typing echo.

4. Adjust the voice rate by moving the slider bar. Use left arrow or right arrow to adjust the speaking rate. Page up or page down will allow you to move in larger chunks.

5. When done changing the voice rate, press tab to move forward through the dialog box. Shift + tab will move back through the dialog box if needed.

6. Next you can control how much punctuation is spoken. Use arrows to make choices in the combo box. Tab when finished.

7. Tab again. You will be taken to a group of buttons. These buttons are to change typing echo. Typing echo is what you hear when you type.

8. Use up arrow or down arrow to select the button you want.

9. At any time, get help by pressing insert + F1. Try this frequently when you are first using JAWS. Escape to close the "help" window.

10. Try getting help when on the key echo radio buttons.

11. In the help window, use up arrow or down arrow to read. Escape to close the help window.

12. Enter to go to the next screen in the wizard.

13. The screen will allow you to change when JAWS is started.
14. Learn about what each option is.

A. If you set JAWS to load before the log in screen, speech will be available when logging in with your name and password.
B. You may set the option for JAWS to start running after log in for all users. In this way, JAWS would always be running for you when you want to use speech with your PC.
C. You can set JAWS to start after log in for "only this user". How you set JAWS to run depends on your individual situation. If you are the only person using your computer, then these options won't be quite as important to you.

15. Enter to go to the next screen.

16. Keyboard settings allow you to control use of a Virtual Ribbon Menu, Keyboard Layout, and Initial state of num lock key.
17. JAWS provides a virtual ribbon to make access to menu options user friendly. The virtual ribbon is similar to more traditional ribbons used by computers running earlier versions of Windows.
18. You can control which keyboard layouts that you use with JAWS. For example, you can choose between the laptop or desktop keyboard layout. You should have explored this in an earlier lesson when we changed the keyboard layout to laptop.

19. The use of NUMLOCK can be controlled. We'll leave it off for now. If you want to learn more about this, use insert + F1 to get help.

20. Verbosity settings are on the next screen.

21. Verbosity settings include tutor messages, access keys, verbosity level, and graphic verbosity. Verbosity is the amount of help JAWS will automatically give you.

22. Use arrow keys to choose. Get help as needed.

23. There is also a Braille screen. You may not be starting with Braille. Space on the Finish button to exit the wizard. Follow any instructions your PC gives.
Lesson D

The JAWS Options Menu

Introduction

Use the JAWS options menu to change and explore the various changes you can make to how JAWS speaks and runs. The "Options" menu is found in the JAWS window. There are basic settings, settings for changing voices, and options for using braille. You can also manage application settings.

In The "Basics" pull-down menu of JAWS options, you have choices regarding tutor messages and access keys. You can alter how much JAWS speaks when in menus or dialog boxes. You can tab through the dialog boxes that open when you are exploring areas of the "Options" menu. Pressing insert + F1 will be a good way for you to learn what specific items are.

In the "Options" menu, there are many aspects of the voice for JAWS that you can change. More choices can be found here than in the JAWS Start-Up wizard that we explored earlier. It is recommended that you read or listen to training materials and use "help" to explore various menu items.
Lesson D

The JAWS Options Menu

Show What You Know:

1. Where can the JAWS "Options" menu be found?

2. How does the "Options" menu compare to using the JAWS start-up wizard?

3. What can be changed by using the Options menu?
Lesson D

The JAWS Options Menu

Try It Out:

Follow the steps provided to begin exploring the JAWS options menu.

1. Explore the options menu. Use \texttt{alt + tab} to open the JAWS window.

3. \texttt{Alt} to jump to the menu bar.

4. \texttt{Down arrow} to open the "Options" pull-down menu.

5. \texttt{Enter} to explore options found in "Basics".

6. \texttt{Tab} or \texttt{shift + tab} through the dialog box.

7. Press \texttt{insert + F1} on each item. Jaws will give help information. \texttt{Escape} to close the help message.

8. Explore making changes to see how JAWS works for you.

9. Complete the same steps to explore "voices" in the options menu. Remember to use \texttt{insert + F1} to get help.

10. Explore other items in the Options menu as needed.
Lesson 1
The PC Desktop
Introduction

What is the desktop of your computer? The desktop is the area of the screen you see after turning on your computer and logging in. The top part of the desktop contains many icons. When the icons are clicked on, the computer user will be taken to applications, folders, or documents on the computer.

At the bottom of the desktop is a bar. On the left-most corner of the bar is the start button. When this button is clicked on, the start menu opens. To the right of the start button is a taskbar. When you have programs running, they are listed in this area. To the right of the taskbar is a notification area. This area tells you about computer operations such as sound and internet access. The time is displayed in the right-most corner of the notification area.

The PC desktop is very helpful. From this home base, you can get to all other areas of the computer. Use your desktop wisely!
Lesson 1
The PC Desktop

**Show What You Know:**

1. Name the parts of a desktop.

2. What is on the upper portion of the desktop?

3. Make an illustration of the desktop that could describe its parts.

4. List the specific icons on your desktop. Write them in alphabetical order.
Lesson 1
The PC Desktop

Try It Out:

Using keyboard commands can save time. You can keep your hands on the keyboard without using the mouse. Practice these shortcut commands.

1. When on the upper part of the desktop, use the initial letter of an icon to jump to the icon.
2. When you want to select an icon without opening it, press space.
3. Press enter to open a desktop icon.
4. Press alt + F4 to close a program or document.
5. Tab can be used to move from the desktop to the start button to the taskbar.
6. Shift + tab will reverse the direction of movement.
7. When using JAWS, say the time with insert + F12.
8. When using the laptop keyboard layout, CAPS LOCK is a modifier key for insert. Instead of pressing the insert key, you may use CAPS LOCK.
Lesson 2

Computer or My Computer

Introduction

In the start menu there is a "Computer" or "My Computer" item. On some computers, there is a desktop icon called "Computer" or "My Computer". Press the windows key to open the start menu (if using Windows 7) tab to the right column of the start menu. Down arrow to "computer" and press enter. There are many ways to access the "My Computer" area of your PC.

In "My Computer" you can access different computer drives. The "c" drive is the hard drive of your computer. That is where programs and other files are stored. The "d" drive is usually a compact disk player. The name of the CD will show up when one is installed on your computer. If you are using a thumb-drive, drive "e" or "f" is usually where this will show up. To access information on different drives, you will need to know how to use "Computer" or "My Computer".
Lesson 2
Computer or My Computer

Show What You Know:

1. Describe one method of opening "Computer" or "My Computer" on your PC.

2. What can be found in drive "e" or "f"?

3. What drive letter is usually assigned to the hard drive?

4. On your PC, what is displayed when you open Computer or My Computer?
Lesson 2

Computer or My Computer

Try It Out:

Using keyboard commands can save time. You can keep your hands on the keyboard without using the mouse. Practice these shortcut commands. These are Windows commands, not JAWS commands.

1. Open My Computer or Computer from the Start Menu or desktop
2. Press insert + t to have JAWS say the window title.
3. In a list of folders or drives, use the initial letter of an item to jump to it. Try this in "Computer" or "My Computer:.
4. Use control + home to jump to the top of a list.
5. Control + END will jump to the bottom of a list.
6. Alt + left arrow will move back to the previous open window.
7. Control + w will close an open window.
8. Windows key + e will open the "Computer" or "My Computer" system. This is known as Windows Explorer.
9. To have JAWS speak the date, press insert + F12 twice quickly.
Lesson 3

Microsoft Word

Introduction

A word processor, such as Microsoft Word, can be used for writing and editing. To open Microsoft Word (if using Windows 7) press the start button to open the start menu. Write the word word. Press enter. A blank document should open. Just start writing in the document. When you are finished, the document can be saved or printed. Unless you change the option, the document will be stored in your Documents or My Documents folder. There are many ways to create and save documents. Microsoft Word and other word processors are useful for completing tasks at school and home.
Lesson 3
Microsoft Word

Show What You Know:

1. Describe one way of opening a blank Microsoft Word document or other word processor.

2. What can you do with a document after it is written?

3. Name 5 tasks you could use a word processor for.
Lesson 3

Microsoft Word

Try It Out:

1. Open the start menu.
2. Type the word 'word'.
4. Before you begin writing a document, change to single or double space. Control + 1 will set the line spacing to single. To set line spacing to double, press control + 2.
5. Write in your document.
6. To save a document, press control + s. Just start writing to name the document. Enter to save the document in your Documents or My Documents folder.
7. Control + p can be used to print. You may print if you are connected to a printer and this has been set up.
8. To center a line of text in a Microsoft Word document, use control + e.
9. Control + l (that's letter L) will left justify a line of text.
10. Use alt + F4 to close the open application.
Lesson 4

Insert Clipart

Introduction

In a Microsoft Word document, you can insert a picture from the clipart gallery. Using graphics may assist you in creating a variety of projects. On the ribbon, you will find an **insert** tab. Within **insert** there is a clipart button that will bring up a search pane for using the clipart gallery. Clipart can add color and fun to your Microsoft Word creations.
Lesson 4

Insert Clipart

Show What You Know:

1. Where can you locate the option to insert clipart?

2. How might inserting a picture make some projects better?

3. Discuss projects in which using clipart would be appropriate? When might inserting an image not be a good idea? Explain.
Lesson 4

Insert Clipart

Try It Out:

In a Microsoft Word document, try the following process to insert an image from the clipart gallery. You can complete the process without using the mouse.

1. Press **alt + n + f** to bring up the clipart search area.
2. Begin writing. Write a search term for an image you would like to find.
3. Press **enter** to begin the search.
4. **Tab** to the results pane.
5. Use up arrow or **down arrow** to explore the results.
6. Press **enter** on your choice to insert it into the document.
7. If you need to move up by screen, use the PAGEUP key. PAGEDOWN will move down by screen in your document.
Lesson 5
Maximize and Minimize

Introduction

Sometimes when in a document or on a web page, it will be helpful to maximize or minimize. Maximizing an item makes it as large as it can be. This can be helpful in seeing the document or in hearing it read by a screen reader.

Minimizing a document is similar to hiding it. The document is still open, but it is hidden. Minimizing an application can be helpful if you want to access another area on your PC, such as the desktop, while keeping the work at hand open. Maximizing and minimizing can assist you in becoming more efficient when completing many computer tasks.
Lesson 5
Maximize and Minimize

Show What You Know:

1. What does maximize mean?

2. What does minimize mean?

3. Describe a situation in which maximizing or minimizing might be of value.
Lesson 5
Maximize and Minimize

Try It Out:

Try these steps to practice using keyboard commands.

1. Open a word document.
2. Ensure the document is maximized. Press \texttt{alt + space}. Then press the letter \texttt{x}.
3. Minimize the document. Press \texttt{alt + space}. Press the letter \texttt{n}.
4. Open another document. Write in the document if you wish.
5. Open the first document. \texttt{Alt + tab} can be used to switch between open documents or programs. If you have many items open, alt + tab quickly will toggle among the various open windows.
6. Minimize all with \texttt{windows key + m}.
7. To open JAWS window use \texttt{insert + j} as a quick shortcut.
Lesson 6

Reading in a Word Document

Introduction

Open a Microsoft Word or other word processor. Write a heading as you would for a required assignment. Then write a paragraph or two. Windows provides many commands that you can use for moving around the document. The commands will work with or without a screen reader. Keeping your hands on the home row instead of reaching for the mouse can help you save time when editing a document.

As an example, control + home will jump to the top of a document. Control + END will jump to the end of a document. HOME will jump to the beginning of a line. To jump to the end of a line of text, use the END key.
Lesson 6

Reading in a Word Document

Show what You Know:

1. In a document on a line of text, what does the END key do?

2. How can you jump to the beginning of a document?

3. What is the advantage of using keyboard shortcuts instead of the mouse?
Lesson 6
Reading in a Word Document

Try It Out:

Follow the steps listed here to practice using keyboard commands.

1. Open an existing document that you have saved in Documents or My Documents. Use the Windows Key to open the start menu. Tab to the second column (Windows 7).
2. Down arrow to Documents or My Documents. Press enter on Documents or My Documents.
3. Press the initial letter of your document until it is highlighted. Enter to open the document.
4. Jump to the end of the document with control + END.
5. Jump back to the top with control + HOME.
6. Navigate by line. Use up arrow or down arrow.
7. Navigate left or right by character. Use left arrow or right arrow.
8. You can navigate back by word or forward by word. Control + left arrow will read back by word. Control + right arrow will move forward by word.
9. Place the cursor in front of any corrections. Use backspace to delete the character to the left of the cursor.
10. Control + s to save any changes you have made.

If you created a new document, the "save" dialog box will appear. Just start writing to name the document. Enter to save.
Lesson 7
Cut, Copy, and Paste

Introduction

Sometimes when editing a document it is necessary to delete or move text around. When you "cut" text to the clipboard, you remove it from the document and place it on the clipboard. The clipboard is an invisible area where text or graphics are stored. Information stays on the clipboard until you paste it somewhere else or until you place other information on the clipboard.

To "copy" text to the clipboard means that you leave one copy in the original location and move another copy to the clipboard. You may paste text from the clipboard to the position where your cursor is located. Use the commands below to practice copying, cutting, and pasting in a document that is for practice.
Lesson 7
Cut, Copy, and Paste

Show What You Know:

1. Explain the difference between "copying text" and "cutting text".

2. What is the clipboard?

3. Where is information "pasted" from the clipboard to?

4. Describe a situation in which you may need the clipboard.
Lesson 7

Cut, Copy, and Paste

Try It Out:

Practice the commands listed here.

1. Open a practice document. Write some numbered sentences.
2. Select the entire document. Use control + a.
3. Cut the text to the clipboard. Use control + x.
4. The information is now on the clipboard, but not in your document. Paste the text back in your document by using control + v.
5. Select all text again. Copy it to the clipboard by using control + c.
6. Jump to the end of the document. Press enter twice. Paste the text from the copy on the clipboard. Press control + v. Now you have two copies of the same text.
7. You can select by line. Use shift with up arrow or down arrow.
8. Select text by character with shift added to right or left arrow.
9. Control + shift + right arrow will select by word to the right. Control + shift + left arrow will select by word to the left.
10. Shift + END will select from the cursor to the end of a line. Shift + HOME will select from the cursor to the beginning of a line.

Practice using the select, cut, copy, and paste commands to move text around in a document. Text will remain on the clipboard until it is replace by something else. You can use the delete key or backspace key to delete selected text.
Lesson 8

Dialog Boxes

Introduction

When using the computer, you will often interact with dialog boxes. In a dialog box, there is usually an underlined button. This is the default button. Pressing enter anywhere in the dialog box will activate the default button.

Tab can be used to move forward in a dialog box. Shift + tab can be used to move back by item in a dialog box. Space will check and uncheck items as needed. Arrow keys will often assist you in making choices in combo boxes or moving slider bars.
Lesson 8
Dialog Boxes

Show What You Know:

1. What is the keyboard command to move forward through a dialog box?

2. What does \texttt{shift + tab} do in a dialog box?

3. How can you check or uncheck an item (such as a checkbox)?
Lesson 8
More with Word and Dialog Boxes

Try It Out:

Follow these steps to practice Windows keyboard commands.

1. Open a new or existing word document. If you do not have text in the document, write a paragraph.

2. Read and edit your document. Use keyboard commands rather than the mouse if you can.

3. To save the document, use control + s.

4. Open the print dialog box with control + p.

5. Use tab and shift + tab to practice navigating around the dialog box.

6. Enter will activate the default button and print the document (assuming you are connected to a printer).

7. Alt + F4 will exit the document.
In a Microsoft Word document, you can format text as needed. This can be done by using windows shortcut commands. Highlight text that you want to bold, underline, or italic. Then use a keyboard command to change the format of the selected text. You may also use the keyboard command before writing the text, write the text, then toggle the format command back off.

As needed, you can change the text size. Control + shift + . can be used to increase the font size. To decrease the font size, use control + shift + -. On a PC, don't worry if you make an error. Control + z will undo the last action that you completed. Try it out!
Lesson 9
Format Text

Show What You Know:

1. When using a PC, what can you do if you want to undo the last action on the computer?

2. What does alt do?

3. What command can be used to make the text size larger?
Lesson 9

Format Text

Try It Out:

Follow the steps below to practice using keyboard commands to change the format of text.

1. Create a new word document or open an existing document. Write in the document in order to have text to practice with.

2. Select a line of text. When at the beginning of a line, press `shift + END` to select that line of text.

3. Press `control + b`. This command will bold the text. `Control + b` again will toggle bold off.

4. You can do anything you want to selected text to change it. Increase the size by using `control + shift + .` and decrease the size by using `control + shift + ,`.

5. `Control + u` can be used to toggle underline on or off.

6. Toggle italic on or off by using `control + i`.

7. Practice using commands as time allows.
Lesson 10

Change the Background

Introduction

In Microsoft Word, the page background of your document can be changed. Press `alt`. Pressing `alt` will move you to the ribbon. Press `p p e` to open the background dialog box. Then `tab` to or `arrow` to the background color you want. Press `enter`.

When making a greeting card or sign, it might be nice to change the background color. This may not be a good idea when writing a research paper. Always check with your instructor before getting too fancy!
Lesson 10

Change the Background

Show What You Know:

1. What command is used to jump to the ribbon?

2. To change the background color, what letters are used?

3. Give two examples of projects that might have colorful backgrounds.

Review:

4. When writing a document, how can you center a line of text or an image?

5. What is the command to left justify an object or line of text?
Lesson 10

Change the Background

Try It Out:

Follow the steps below to change the background of a document.

1. Open an existing document or create a new document.
2. Change the background color to black (Windows 7). Press alt p p c.
3. Tab to "black" and press enter. The text should turn white and the background color will be black.
4. Explore changing the background to other colors.
5. You can change the font color as needed. Press control + a to select all.
6. Press alt h f n to bring up the "font" dialog box. Tab through the dialog box. Make changes as needed. Use enter and arrows to help make changes.
7. Another handy command is to force a new page in a document. Press control + enter to force a new page.
Lesson 11

Folders and Documents

Introduction

When using a computer, it is very important to stay organized. Keeping related information in one folder can help you to locate information quickly. If you keep every document you create in Documents or My Documents without using folders, it may become very time consuming for you to find and open what you need.

Naming folders and documents appropriately is a good way to stay organized. Naming folders and documents by the date or page number may not be enough. Be specific and short. Consistently name your folders and documents so that you don't spend hours searching for what you need.

If you have a folder called Social Studies 12/13 you can keep all Social Studies work for the 2012-2013 school year in the folder. When naming documents in the Social Studies 12/13 folder, be concise. Page 26 Summary, Test 14, Sept 27, or Chapter 8 Study Guide might be examples of document names.
Lesson 11
Folders and Documents

Show What You Know:

1. What are some good ideas to keep in mind when naming folders and documents?

2. List some folders that you could create to help increase organization.

3. What commands can be used to jump to the top and end of lists of folders or documents?
Lesson 11
Folders and Documents

Try It Out:

Follow the steps below. Work with folders and files (documents) without using the mouse.

1. Open the start menu (use the \texttt{windows key}). You may also use \texttt{control + escape}.
2. \texttt{Tab} to the right side of the start menu. \texttt{Enter} on Documents.
3. Change the view to "list". Press \texttt{alt + v}. Down arrow to "list" and press enter. Or, just press the letter l for list. This will allow you to view your folders and files in a list.
4. Press \texttt{alt + f} to open the "file" pull-down menu.
5. Down arrow to the "new" pull-down menu. \texttt{Right arrow} to open the pull-down menu.
6. \texttt{Enter} on Folder.
7. Just start writing to name your folder. \texttt{Enter} when done.
8. Press \texttt{enter} again to actually open the folder.
9. You will have nothing in the folder. Create a new document. Press \texttt{alt + f} to open the "File" pull-down menu. \texttt{Down arrow} to the "New" pull-down menu. \texttt{Right arrow} to open the pull-down menu.
10. Press letter \texttt{w} to open a new word document or arrow down to that option and press \texttt{enter}.
11. Start writing to name the document. \texttt{Enter} to finish. Pressing \texttt{enter} a second time would open the document, but you don't actually need to open the document at this time.
12. Press \texttt{alt + left arrow} to go back to the previous window.
13. For practice, arrow to a document. When it is selected (highlighted) press control + c to copy the document to the clipboard.

14. Arrow to the folder you just created or use its initial letter to jump to it.

15. Enter to open the folder.

16. Paste the document from the clipboard to the folder. Press control + v.

17. As in a document, control + a will select all folders and files in the window you are working in.

18. Press the delete key to delete folders or files.

19. As time, practice creating, moving, and deleting folders and files.
Lesson 12

Internet

Introduction

It's hard to think about using a computer without also thinking about using the Internet. For this lesson, Internet Explorer will be used. Internet Explorer is a web browser. It can be used to access millions of web pages. Children and adults use the Internet for work and school. Conducting research and socializing with friends and family are two examples of how individuals spend time on the Internet.

There are many shortcuts available when using the Internet. Shortcuts can be used to add and go to web pages in the favorites list. The keyboard can be used to change the "view" of web pages or to "print" web pages. The url of a web page is its web address. The url of my web page is https://sites.google.com/site/assistivetech1/.
Lesson 12

Internet

Show What You Know:

1. Give an example of a url.

2. What is Internet Explorer?

3. What are some activities that children might do on the Internet?
Lesson 12

Internet

Try It Out:

Follow the steps below to practice using the keyboard when on the Internet.

1. Open the start menu.

2. Begin typing. Type the name of a url that you want to go to. Press enter.

3. After the page loads, add it to your "favorites" list. Press alt + a. Press enter on "add to favorites.

4. You will land in a text box. If you don’t like the favorite name, just start writing to change it. Press enter to add the favorite to the list.

5. When the "add to favorites" dialog box opens, remember you can use tab, shift + tab, and enter to interact with the options as needed. In a dialog box, use insert + e to have JAWS read the default button to you.

6. You can go back to the favorite when needed. Press alt + a to open the favorites list. Arrow down to the favorite and press enter or use its initial letter to jump to it.

7. You can change the size of the text and images on a web page. Press alt + v to open the "view" pull-down menu.

8. Press x to open the "text size" pull-down menu. Arrow to the size you want, press enter.

9. Remember, you can use alt + F4 to exit the web browser.
Lesson 13
Create a Shortcut Command

Introduction

Often to open an application we go to the desktop, click on an icon, and open the program. This can be done for a program such as Internet Explorer. It is possible to create your own keyboard command that will allow you to open an application. In this way, you can open the program from anywhere on your PC. You don't have to return to the desktop or go to the Start Menu to open Programs. Simply press the keyboard command you create.

You can create a short cut to open almost any program. Make a shortcut to open your e-mail application (such as Outlook), Internet Explorer, or Microsoft Word. It's easy!
Lesson 13
Create a Shortcut Command

Show What You Know:

1. What would be the advantage of creating a keyboard shortcut to open a program?

2. What programs might you want to create a shortcut command to open? Why?

3. Shift + tab is used to move forward through a dialog box. What command is used to move forward through a dialog box?
Lesson 13

Create a Shortcut Command

Try It Out:

Complete the steps below to create a shortcut command that will allow you to open Internet Explorer using a shortcut command.

1. Use `windows key + d` to bring focus to the desktop.
2. Press letter `i` until Internet Explorer is the focus.
3. Press `alt + enter` to open the properties dialog box. Another method would be to right click on the icon. You can press `shift + F10` to right click. Then `down arrow` to "Properties" and press `enter`.
4. Tab to the "shortcut key" field.
5. Press the letter `i`.
6. The shortcut will be set to `control + alt + i` to open Internet Explorer.
7. Tab to continue through the dialog box.
8. At the "run" combo box, you can use `up arrow` or `down arrow` to select normal, minimized, or maximized. If you choose maximized, Internet Explorer will always start "maximized".
9. Press `enter` when done making changes.
10. Now when you press `control + alt + i`, Internet Explorer should run. Try it out!
Lesson 14
JAWS and Reading a Web Page
Introduction

As with most tasks, a screen reader such as JAWS can help you read and navigate web pages more efficiently. **Tab** is used to move forward from link to link. **Shift + tab** will move back by link. To follow a link, press **enter**. When on web pages, there are special JAWS commands to get lists of certain elements. An element is an item such as a link, frame, or heading. Using these lists can make it even faster to navigate web pages. When using JAWS on a web page, you can work in Reading Mode or Forms Mode.

On a web page or anywhere, have JAWS read the status line. Press **insert + downarrow** to get the information on the status line. To say all, press **insert + down arrow**. Try this in various computer applications as well as when on the Internet. **Control** will stop JAWS from reading as needed.
Lesson 14

JAWS and Reading a Web Page

Show What You Know:

1. When using JAWS on the Internet, what two modes are there?

2. What does `insert + down arrow` do when using JAWS?

3. What is the command to "say all"?

4. What is the command to jump to the top of a page or list?
Lesson 14
JAWS and Reading a Web Page

Try It Out:

1. Bring up the start menu.
2. Type in the url www.nfb.org and press enter.
3. JAWS will announce the number of headings and links. Then JAWS will start reading the page. You may press control to stop JAWS from reading.
4. Use up arrow or down arrow to read back and forward by line. Explore the page using up arrow or down arrow.
5. Move to the top of the page. Use control + HOME.
6. Press insert + t to read the page title.
7. Get help. Press insert + F1. You will get a quick tip and will be told about the number of links, headings, and forms on the page. Use up or down arrow to read. Escape to close help. Use inset + F1 to let JAWS help you learn how to navigate web pages and complete other tasks.
9. On a web page, you can move forward by page heading by pressing h. Shift + h will jump back by page heading. Try this on the web page.
10. Letter p will let you jump by paragraph. Shift + p will move back by paragraph.
11. You can get a list of links. Press insert + F7 to bring up the links dialog box. Up arrow or down arrow through the list of links. Enter to follow the link.
12. Insert + h will open the headings dialog box. Arrow through the list of headings. Enter to go to a heading.
13. To go back to the previous web page, use alt + left arrow. Alt + right arrow will take you forward by page in your current session.
14. Explore as time. Alt + F4 to exit when you finish.
Use Surf's Up:

1. Press `insert + j` to open the JAWS window.
2. `Alt + h` to open "help".
3. Press `enter` on "Training".
4. Down arrow to "Surf's Up".
5. Press `enter` to open.
6. Follow given instructions.
Lesson 15

Forms on the Internet

Introduction

There are many web sites with forms that you may interact with. You might fill out a form to request information, join a list, or purchase an item. When filling out a form with JAWS on, you will be in Forms Mode. Forms Mode automatically comes on when you come across an edit box that allows you to write. JAWS will beep to let you know you are in Forms Mode and can write.

On a web page, letter f will jump forward by form. Shift + f will move back by form. Try this out when using JAWS to access a variety of web sites.
Lesson 15
Forms on the Internet

Show What You Know:

1. How does JAWS let you know you are in the edit box of a form and able to write?

2. How can you jump forward or back by form?

3. List three reasons you may need to fill out a form on a web page.
Lesson 15

Forms on the Internet

Try It Out:

Follow the steps to practice writing in forms.

1. Press windows key + d to bring focus to the desktop.
2. Press i to focus on Internet Explorer.
3. Enter to bring up your home page.
4. Press alt + d to go to the address field.
6. Tab to the link titled "request a free white cane" and press enter.
7. Tab to the "online application for a white cane" link.
8. Press enter.
9. Press f to get to the first name edit box. JAWS will beep to let you know you are in Forms Mode. You don't have to write in the form for this example.
10. At any time, you could press Escape to exit Forms Mode.
11. In the form, you can use up arrow or down arrow to navigate to edit boxes. Write anytime JAWS lets you know you are in a form.
12. Tab or shift + tab will also allow you to move around forms. Try this now.
13. Practice as time. Exit the web page when done.

14. If you want to go back to the top of the page, escape to get out of Forms Mode. Then you can use control + home to navigate to the top of the page.

15. Then navigate using commands available in Read Mode.

16. Remember to use insert + F1 to get help.

17. Practice as time.
Lesson A

JAWS Laptop Layout

Show What You Know:

1. What is the difference between many laptop and standard PC keyboard layouts?
Most laptop keyboards do not have a NUMPAD.

2. What key will become a modifier key for the INSERT key?
The CAPSLOCK key will become a modifier for the INSERT key.

3. What is a modifier key?
A modifier key can be used to replace a key. In the case of INSERT and CAPSLOCK, CAPSLOCK may be used instead of INSERT when typing keystrokes.

4. If you want to put a word in all caps, what will you do?
When the JAWS laptop layout is being used, press CAPSLOCK twice quickly to turn all capital letters on.
Lesson B

Starting JAWS

Show What You Know:

1. When installing JAWS, where is a shortcut to run the program placed?
   The JAWS shortcut appears as an icon on the desktop.

2. What is a second method that can be used to run JAWS?
   A hotkey can be set up to run JAWS.

3. What is the keyboard command to shut JAWS off?
   Insert + F4 will shut JAWS off. Press enter when the shut-down dialog box opens.

4. How can you turn keyboard help on or off?
   Press insert + 1 to toggle keyboard help on or off.
Lesson C
JAW Start-Up Wizard

Show What You Know:

1. Give 3 options that the JAWS start-up wizard can help you change?
The JAWS start-up wizard can help change speech, keyboard, and JAWS start-up options.

2. To get JAWS help from anywhere, what command can be used?
Insert + F1 will give help.

3. How can "help" be closed?
Press escape to close help.

4. What is the command to bring focus to the desktop?
Windows key + d brings focus to the desktop.
Lesson D

The JAWS Options Menu

Show What You Know:

1. Where can the JAWS "Options" menu be found?

The options menu is found in the JAWS window. Press alt + tab to bring focus to this window when JAWS is running.

2. How does the "Options" menu compare to using the JAWS start-up wizard?

There are more choices to make and options to change in the Options menu.

3. What can be changed by using the Options menu?

Voice, basic settings, and braille can be changed by using the Options menu.
Lesson 1
The PC Desktop

Show What You Know:

1. Name the parts of a desktop.
   The desktop contains icons, a start button, taskbar, and a notification area.

2. What is on the upper portion of the desktop?
   Icons are on the upper part of the desktop.

3. Make an illustration of the desktop that could demonstrate its parts.
   This illustration could be used to teach someone who does not have a computer or who is just learning about computers and what the desktop is all about.

   Projects will vary.

4. List the specific icons on your desktop. Write them in alphabetical order.
   Answers will vary according to what is displayed on the desktop.
Lesson 2
Computer or My Computer

Show What You Know:

1. Describe one method of opening "Computer" or "My Computer" on your PC.
   Answers may vary.

2. What can be found in drive "e" or "f"?
   Usually a removable disk (such as a thumb-drive) is found in drive "e" or "f". The drive will show up when the thumb-drive is inserted.

3. What drive letter is usually assigned to the hard drive?
   The hard drive is usually the c drive.

4. On your PC, what is displayed when you open Computer or My Computer?
   Answers may vary.
Lesson 3
Microsoft Word

**Show What You Know:**

1. Describe one way of opening a blank Microsoft Word document or other word processor.

   Answers will vary according to the computer and operating system you are using. In Windows 7, you may press the windows key to open the start menu. Type *word* and press enter. A blank document will be opened.

2. what can you do with a document after it is written?

   After you write in a document, you can save it or print it.

3. Name 5 tasks you could use a word processor for.

   Answers will vary.
Lesson 4

Insert Clipart

Show What You Know:

1. Where can you locate the option to insert clipart?
   Find this choice on the ribbon under the Insert tab.

2. How might inserting a picture make some projects better?
   Answers will vary.

3. Discuss projects in which using clipart would be appropriate? When might inserting an image not be a good idea? Explain.
   Answers will vary.
Lesson 5

Maximize and Minimize

Show What You Know:

1. What does maximize mean?
Maximize means to make large.

2. What does minimize mean?
Minimize means to make smaller, to reduce in size.

3. Describe a situation in which maximizing or minimizing might be of value.

Answers will vary.
Lesson 6

Reading in a Word Document

Show what You Know:

1. In a document on a line of text, what does the END key do?
The END key takes you to the end of a line.

2. How can you jump to the beginning of a document?
Control + HOME will jump to the beginning of a document.

3. What is the advantage of using keyboard shortcuts instead of the mouse?
Answers will vary.
Lesson 7

Cut, Copy, and Paste

Show What You Know:

1. Explain the difference between "copying text" and "cutting text".

Cutting text removes it from the original location and places the information on the clipboard. Copying text makes a copy of the original and places it on the clipboard. The text stays in its original location as well as on the clipboard.

2. What is the clipboard?

The clipboard is a storage area. You can't see it, but information is kept there after it is copied or cut from a document.

3. Where is information "pasted" from the clipboard to?

Information is pasted at the location of the cursor.

4. Describe a situation in which you may need the clipboard.

Answers will vary.
Lesson 8

Dialog Boxes

Show What You Know:

1. What is the keyboard command to move forward through a dialog box?
   Tab will move forward through a dialog box.

2. What does shift + tab do in a dialog box?
   Shift + tab moves back through dialog box items.

3. How can you check or uncheck an item (such as a checkbox)?
   Space will check or uncheck an item.
Lesson 9
Format Text

Show What You Know:

1. When using a PC, what can you do if you want to undo the last action on the computer?
   Control + z will undo the last action.

2. What does alt do?
   Pressing alt will take you to the ribbon or menu bar across the top of the open application.

3. What command can be used to make the text size larger?
   Control + shift + . will increase the text size.
Lesson 10
Change the Background

Show What You Know:

1. What command is used to jump to the ribbon?
Alt is used to move to the ribbon.

2. To change the background color, what letters are used?
The letters p p c are used to open the dialog box where you can change the background color.

3. Give two examples of projects that might have colorful backgrounds.
Answers will vary.

Review:

4. When writing a document, how can you center a line of text or an image?
Control + e will center an object or text.

5. What is the command to left justify an object or line of text?
Control + l will left justify.
Lesson 11

Folders and Documents

Show What You Know:

1. What are some good ideas to keep in mind when naming folders and documents?
   Answers will vary.

2. List some folders that you could create to help increase organization.
   Answers will vary.

3. What commands can be used to jump to the top and end of lists of folders or documents?
   Control + HOME will jump to the top. Control + END will jump to the end.
Lesson 12
Internet

Show What You Know:

1. Give an example of a url.
   Answers may vary.
2. What is Internet Explorer?
   Internet Explorer is a web browser.
3. What are some activities that children might do on the Internet?
   Answers will vary.
Lesson 13

Create a Shortcut Command

Show What You Know:

1. What would be the advantage of creating a keyboard shortcut to open a program?

Creating a keyboard shortcut to open a program can help save time. To open a program, don't return to the desktop or go through the Start Menu. Just press the shortcut command.

2. What programs might you want to create a shortcut command to open? Why?

Answers will vary.

3. Shift + tab is used to move forward through a dialog box. What command is used to move forward through a dialog box?

Tab is used to move forward through a dialog box.
Lesson 14
JAWS and Reading a Web Page

Show What You Know:

1. When using JAWS on the Internet, what two modes are there?
The two modes are Reading Mode and Forms Mode.

2. What does insert + down arrow do when using JAWS?
Insert + down arrow will read the status line.

3. What is the command to "say all"?
Insert + down arrow is the command to "say all".

4. What is the command to jump to the top of a page or list?
Control + home will jump to the top.
Lesson 15
Forms on the Internet

Show What You Know:

1. How does JAWS let you know you are in the edit box of a form and able to write?
JAWS will beep when Forms Mode is on.

2. How can you jump forward or back by form?
Use f or shift + f to move forward or back by form.

3. List three reasons you may need to fill out a form on a web page.
Answers will vary.
PC and JAWS Commands Checklist

<table>
<thead>
<tr>
<th>Task and Keyboard Shortcut</th>
<th>Date</th>
<th>Score</th>
<th>Date</th>
<th>Score</th>
<th>Date</th>
<th>Score</th>
<th>Date</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Bring focus to desktop (windows key + d) Lesson .</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Turn JAWS off as needed (insert + F4). Lesson B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Close a program (alt + F4). Lesson 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Jump to the top of a document or list (control + HOME). Lesson 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Jump to end of document or list of folders/files (control + END). Lesson 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Move back to previous page or open window (alt + left arrow). Lesson 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Close the open window (control + w). Lesson 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Open windows explorer (windows key + e). Lesson 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Save a document (control + s). Lesson 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Print a document (control + p). Lesson 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. Set line spacing to single (control + 1). Lesson 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. Set line spacing to double (control + 2). Lesson 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. Left justify in a document (control + L). Lesson 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14. Center a line of text (control + e). Lesson 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15. Read title bar with JAWS (insert + t). Lesson 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16. Move to beginning of line of text (home). Lesson 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17. Move to end of a line of text (end). Lesson 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18. Say the current line (insert + up arrow). Lesson B</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19. Navigate by line (up or down arrow). Lesson 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20. Move left or right by word (control with left or right arrow). Lesson 6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21. Select all text, folders, or files (control + a). Lesson 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22. Copy to clipboard (control + c). Lesson 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23. Cut to clipboard (control + x). Lesson 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24. Paste from clipboard (control + v). Lesson 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25. Select text (shift with arrow keys). Lesson 7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26. Say all (insert + down arrow, control to stop). Lesson 14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27. Bold text (control + b). Lesson 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28. Underline text (control + u). Lesson 9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29. Speak default button in dialog box (insert + e). Lesson 12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30. Read status bar (insert + page down). Lesson 14</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Rosa Mauer